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Web Page Development using SeaMonkey Syllabus

Course Description:
This workshop will introduce basic concepts regarding web page development on a Mac-
intosh OS X system. Using Mac OS X, we will explore how to create a web page, upload 
it into an NEIU account, and how to view the web page from a browser.

Prerequisites:
Basic understanding of Macintosh OS X or attendance to the Introduction to Macintosh 
workshop. Basic knowledge of the Internet and Internet Applications.

Goal(s) of the Workshop:
Participants should leave with an understanding of how to create their own web page 
using Netscape Composer on a Macintosh system. This workshop can also serve as a 
foundation for the Web Page Development using iWeb workshop.

Course Content:
· create an HTTP directory
· create a blank web page
· create links
· insert pictures
· use ftp to upload files
· preview the web page online
· editing an existing web page.

Disclaimer:
The Web Page Development using SeaMonkey workshop is recommended for people 
unfamiliar with web page development. Basic knowledge of the Macintosh Operating 
System is necessary in order to maximize results from this workshop. The screen cap-
tures found in this document are based on the Macintosh Operating System X.
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About SeaMonkey Composer

SeaMonkey Composer is a free HTML editor. It is part of the SeaMonkey application. Com-
poser is a WYSIWYG (what you see is what you get) HTML editor which enables people who 
have little or no prior knowledge of the HTML language to create web pages. Netscape is 
available for download at www.mozilla.org for Windows, Linux, or Macintosh.

This tutorial will demonstrate the basics of SeaMonkey Composer. The purpose of this 
document is to enable users to create a simple HTML document; it is not intended to teach 
advanced web design techniques.

Remember that you always have access to the help menu. In addition, placing the arrow 
cursor over the buttons in SeaMonkey Composer will provide information about its function.

A few words regarding web page creation:
· Plan your page/site before you begin. Make sure that you have all the images and 
text files before you start.
· To minimize the possibility of broken links, keep all of your web files in a single 
folder. 
· Keep graphics files small. Large graphics will cause your web pages to load slowly.
· Preview your web pages in multiple web browsers (such as Internet Explorer, Safari, 
etc . . .) to ensure that your page appears consistent on different programs.
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Beginning a New Composer Document

To begin SeaMonkey Composer, launch SeaMonkey. A web browser win-
dow will appear on the screen by default. To access Composer,
click on:

File --> New --> Composer Page

A blank Composer document will appear on the screen. This is where you will create your 
web page. Composer is designed to be easy to use and its commands are set up in a simi-
lar manner and style as a word processor. 
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Inserting and Manipulating Text

You may enter text into the document simply by typing on the keyboard. The text will wrap 
around the screen just like a word processing program. Pressing the [Return] key will in-
sert a hard carriage return and place the cursor at the beginning of the next line.

Fonts, Font Sizes, and Colors

You may manipulate the font, font size and style, and the font color via the Format menu. 
You may also manipulate the text by using the tool bar:

Tool Bar

If you wish to manipulate text which has already been typed, you must highlight the text by 
selecting it first before changing its size, style, or color. This behavior is consistent with how 
standard word processors function.
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Changing the Web Page Background

SeaMonkey Composer allows you to change the background color of your web page.

To change the background, click on Format  menu and choose Page Colors and Back-
ground.

In the following window, you may set the webpage 
to use the Reader’s default colors or to Use 
custom colors. 

If you elect to use custom colors, click on the col-
ored boxes next to the categories (normal text, 
link text, etc . . .) to choose a specific color for that 
category.

You may then choose any color which appears in the 
color palette. Once you have chosen a color, click on the 
OK button.

Feel free to experiment with different color combinations 
until you find one which suits your tastes and your web 
page.
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Images

To insert an image in a Composer document, you must first have the image file saved on 
the hard drive, diskette, CD, or some other volume. Use only a .gif or .jpg format for im-
ages intended for the internet. .gif files work well for images comprised of primary colors. 
.jpg files are suitable for photo-like images. Your images can come from a scanner, a digital 
camera, or be downloaded from the internet.

To Insert an Image

• place the I-bar cursor in the composer document where you want the image 
to appear.

• click on the Image button in the tool bar

(You may also use the menu bar to insert a picture file by clicking on
Insert --> Image...)

The following window will appear.

• Click on the Choose File button to 
select the image you wish to insert 
into the web page.

(Alternate text refers to text which shows 
up on the webpage in place of web images 
which do not load properly. If you do not 
wish to have alternate text appear on the 
webpage, click on the radio button next to 
the option Don’t use alternate text.)

• A standard Open dialog box will ap-
pear. Select the image file and click 
Open.

• Then, in the Composer Insert Im-
age window, click on the button OK.

Note: In order to simplify your web page file 
structure and to minimize the possibility of 
broken links, keep all your html files and 
image files in a single folder.
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Manipulating an Image

You may change the height and width of an 
image by double-clicking it.

In the subsequent Image Properties win-
dow, click on the Dimensions tab and 
choose Custom Size.

Enter the desired image dimensions and 
then click on the OK button. The image will 
now be resized according to the dimension 
changes you entered in this window.

The Constrain option allows you to resize 
your pictures proportionally.

Important: Web pages do not truly contain your image. They merely point to your image file 
location. When uploading your web pages to a server, be certain to upload the image files as 
well as the .html web pages.
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Links

One of the most important features of a web page is that it contains links to other sites on 
the web. This allows the computer user to quickly jump to other web pages to view addi-
tional information.

External Links

An external link is a link which takes the user from one web page to another. For example, a  
link which takes you from the Chicago Sun-Times homepage to the Amazon online store.

To create a link, first choose the text (or image) on your web page which will serve as the 
link. Highlight the text (or click on the image) to select it.

Next, click on the Link button on the tool bar. 

Alternatively, you may also click on the Insert  menu and choose Link.

The following dialog box will appear:

Enter the web page address. For example, to link your web page to the Northeastern Illinois 
University homepage, you would enter:

http://www.neiu.edu 

Click on the OK button when finished. The selected text or image on the web page is now a 
link to http://www.neiu.edu 
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Internal Links

Internal links refer to links which take the user to another section of the same web page. 
The method to create an internal link is slightly different than that of creating an external 
link.

Creating an Anchor

Before you can create an internal link, you must first locate the destination that you want 
the link to jump to. Click on that location so that the I-bar cursor appears there.

Next, click on the Insert menu and select Named Anchor.

A dialog box will appear. Enter a name for the anchor.

Choose a name which will identify its location to you.

A little anchor image will appear on the page. This anchor image will mark the loca-
tion of the anchor you just created. 

Please note that the small anchor icon will not be visible when the page is viewed with a 
web browser. It is only visible when viewed with Composer.
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Creating an Internal Link

To create a link that will jump to the anchor you just created, select the text (or 
image) you want to be the link.  Click on the Link button.

The Link Properties window will appear.

Instead of typing in the web page address as 
the destination, you may click on the down 
arrow to select the anchor. If you have more 
than one anchor on the page, they will all be 
available in the menu.

After you click OK, the internal link will have 
been created.

E-Mail Links

You have the option of creating a link on your web page which would allow the user to write 
to your e-mail address. The procedure to create an e-mail link is very similar to the proce-
dure for creating an internal or external link.

After selecting the text or image which you want to serve as the e-mail link, click on the 
Link button on the tool bar. 

In the Link Properties window, enter:
mailto:YourAddress@somewhere.someplace 

When the user clicks on this link, the computer will automatically launch the user’s default 
e-mail program and enter your e-mail address as the recipient. This type of link does not 
work with web-based e-mail programs such as NEIU’s WebMail system.
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Saving Your Web Page

Be sure to save your file frequently, even before you complete your web page. This will help 
ensure that your work will not be lost in the event of a computer failure.

To save the web  page, click on File --> Save As

The first time you save the file, Composer will ask you to enter a page title. The title will 
appear in the title bar of the web page and will also be used to identify it when a user 
bookmarks your page.

A standard save file dialog will appear. Save your file. If you are saving a page which is in-
tended to be your home page (the first page your online visitors will see), it is suggested 
that you call your file index.html. Be sure to select the Format for the web page to be 
HTML Files. 

your home page 
should be entitled 
index.html

web pages are 
saved as .html 
format
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Launching Fetch

To upload your file(s) to a server, you will need to know the host name of the server, your 
username, and password. In order to view your web page on the Internet, the files will 
need to be uploaded to a directory named http. 

You will be using the same username and password as the one assigned to you for NEIU 
webmail. If you do not know your NEIU username and password, please visit our depart-
ment website at www.neiu.edu/~scs and click on the link “Student Email Account Lookup.”

In our Macintosh computer labs we use the ftp program Fetch.
To launch Fetch, click on the icon in the dock.

A window will appear on your screen. Enter the 
following settings:

Host: ftp.neiu.edu
User ID: your NEIU username
Password: your neiu password

Note: the username and password are case-
sensitive.

Do not select Add to keychain.
When finished, click on the Connect button.
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Transferring Files to Your NEIU Account

After you successfully connect to your NEIU account in Fetch, a window similar to the one 
shown below will appear. It lists the files that are stored in your NEIU account. Locate the 
http directory you created earlier in this manual. Double-click on http to open it. If your 
http folder has a home.htm file which you did not create, delete it so it does not interfere 
with your index.html file. To delete a file, click on it to select it and then click on the De-
lete button situated in the Fetch toolbar.

After opening your http directory, drag the Fetch window to one side of the screen. Then 
locate the web page files within the Macintosh operating system and adjust the windows on 
your screen so you can see both the Fetch window and your web page files at the same 
time.
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Drag your web page files (index.html and the Sites folder) to the Fetch window. Your web 
page files will be copied from the computer to the http directory in your NEIU account. De-
pending on the size and number of files and the speed of your Internet connection, the file 
transfer may take a few moments to complete.

After the files have been uploaded to your http directory within your NEIU account, you 
may view your newly-created web page by launching a web browser and typing in the ad-
dress:

http://www.neiu.edu/~your-neiu-account-username

The ~ (tilde) key is found beneath the ESC key on the keyboard. For instance, if your user-
name is jsmith, then your web page address will be:

http://www.neiu.edu/~jsmith

By default, the web browser looks for a file called index.html. The index file will be displayed 
on the screen for you to view. Please remember that index.html and Sites must be in the 
http folder in order to be accessible from the Internet.
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Creating Your HTTP Directory and Fixing Permissions

If you do not have an http directory in your NEIU account or if you need to approve the 
permissions of the files within your http directory, please follow the instructions below. You 
do not need to follow these directions each and every time you publish a web page.

Click on the Gamut icon in the dock. It will open an SSH session to 
the Gamut server.

The window will ask you to enter your login name. Enter your NEIU username and click on 
the Connect button.

A new window will appear and ask you to enter your NEIU password. Enter your password 
and press the Return key. Note: When you type your password, it will not appear on the 
screen.

After you successfully log into the server, you will be at the gamut 
prompt. Type the word setup and press the Return key.

The setup program does the following:

1. If you do not have an http folder in your account, setup will create one for you.
2. If you are unable to view your web page files online, setup will set file and directory 

permissions to allow anyone to view the files stored in the http folder.

Web Page Development using SeaMonkey
 16 of  19
 Aug 23, 2006



Choose option B by typing the letter “B” via the keyboard. The computer will return the 
message Fixing World-Wide-Web permissions - One moment. After several seconds, 
the computer will then report that:

Press any key to continue.

The window will return to the previous options. Choose X to exit the setup menu. Then 
type exit and press <Return> to exit the SSH session.

You have now successfully created a directory named http in your NEIU account. You will 
store your web page files within the http directory and these web pages will be accessible 
by anyone with an Internet connection.
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Additional Assistance with SeaMonkey Composer

SeaMonkey Composer comes with a Help Menu to allow users to learn and use SeaMon-
key on their own. Assistance can be accessed from the Help menu by selecting Help and 
Support Center.

A help window will appear. The help system will list a series of possible solutions according 
to subject categories. As you see, there is a heading entitled Creating Web Pages.
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Conclusion of Document

Academic Computing hopes that this document has been of use to you in familiarizing your-
self with web page development on a Macintosh Operating System. Please direct any com-
ments you have concerning our workshops or this document to Academic Computing at B-
107, extension 4390.

Information Resources

Information regarding student workshops, documentation, e-mail accounts, and lab loca-
tions is available at our website http://www.neiu.edu/~scs 

Student Computing Services
Academic Computing, NEIU

B-107
Web: www.neiu.edu/~scs

Email: scs@neiu.edu
Phone: 773-442-4390

Web Page Development using SeaMonkey
 19 of  19
 Aug 23, 2006

http://www.neiu.edu/~scs
http://www.neiu.edu/~scs
mailto:scs@neiu.edu
mailto:scs@neiu.edu
http://www.neiu.edu/~scs
http://www.neiu.edu/~scs

